
Ms. Jensen’s Classroom Procedures 
Procedures for Entering the Classroom 

Entering the classroom: 
 Enter the classroom quickly and quietly; bring your textbook, pencils, and paper to every class. 
 Turn in any completed homework or fill out a missed homework slip, and pick up graded 

assignments from your folder. 
 Get your materials ready; sharpen any dull pencils. 
 Begin the bellwork. 
 You should be sitting and working on the bellwork when the bell rings. 

 
Bellwork-the bellwork assignment will be different each day.  This short activity will help you by 
reviewing the information we learned the day before, introducing you to new material, or just getting 
your brain ready to learn! 

 Begin the bellwork assignment when you sit down. 
 You will have until I finish taking attendance to work on bellwork. 
 

Collecting homework and picking up graded assignments: 
 Find your folder alphabetically by last name in your class’ 

file.  
 Take your graded assignments.  
 Place your homework in the homework tray.  If you do 

not have your homework, fill out a missed homework 
slip (purple slip).  
 

Pencils: 
 Please remember to bring 2 pencils to class.  If you forget, you will need to 

borrow a pencil from a classmate. 
 

Procedure for Dismissing/leaving the classroom 
Dismissing/leaving the classroom: 

 Two minutes before the end of class, I will announce that it is time to clean up. 
 Clean up any materials and make sure your area is neat.  

→ 10 points of your assignment is cleaning up your area. 
 Return desks if they were moved. 
 Gather any materials you will need to take home. 
 If you were asked to make an “absent folder”, put it in your absent classmate’s folder. 
 I will dismiss the class when it is over; you will not be dismissed unless everybody is seated. 

 
Procedures for Getting My Attention 

Asking a question while I am talking-I will frequently ask if there are any questions, but if you have one 
while I am talking, you can still ask!  



 If you have a question that has to do with what we are learning about, simply raise your hand.  
(If your question is not about what we are learning, please ask it at a different time.) 

 When I see your hand, I will nod at you to let you know that I’ve seen your hand; you can put 
your hand down. 

 Once I get to a point where I can stop, I will call your name, and you can ask your question. 
Asking for assistance during work-follow this procedure when you’re working or reading by yourself. 

The majority of the time you are working, I will be rolling on my trusty stool from group to group.  
When I do, don’t worry!  I will be at your group soon.  If I’m not rolling around… 
 If you need help or have a question that has to do with what we are learning about, raise your 

hand.  (If your question is not about what we are learning, please ask it at a different time.) 
 When I see your hand, I will nod at you to let you know that I’ve seen your hand, and you can 

put it down. 
 I will come to you when it is your turn. 

 
Bathroom procedures 

 Please use the bathroom before or after class. 
 If an emergency arises, raise your hand to ask for permission.  You will not be allowed to go to 

the bathroom if you’re phone is not in its pocket. 
 Before you put on the bathroom pass, use a pump of antibacterial gel. 
 Put on the bathroom pass necklace.  (If you didn’t you would put the pass down in the 

bathroom.  Bathrooms are covered in germs which would contaminate the pass.  Wearing it as a 
necklace keeps it clean and with fewer germs.) 

 Use the bathroom and wash your hands. 
 Use another pump of antibacterial gel when you return.  Then take the pass off and return it. 

 
Dull/broken pencils: sharpening pencils is loud and disruptive.  The only times during our class period 
you may sharpen your pencil is when nobody is addressing the class.  If there is more than one person 
at the pencil sharpener, make a line, and stay quiet.   

 
Procedures for a Smoothly Running Classroom  

Arranging desks for group work or class discussions- we will do lots of different activities so we don’t 
get bored this year.  The way the classroom is arranged right now may not be the best way for all of the 
activities.  So depending on the activity, we will temporarily rearrange the desks.  Arrange them as 
quickly as possible.  We’ll put the desks back during clean up if needed. 

  
Cell Phones- It is disruptive to use a cell phone in class.  Because of the excessive abuse of cell phones in 
the past, I have decided not to allow them out in the classroom under most circumstances.   

 When you enter the class, if you have a cell phone, put it in the cell phone pocket assigned to 
your number. 
→ You will need to use a calculator instead of your phone, so be sure to bring one to class. 
→ Since you can’t have your cell phone during class, you can only listen to music if it’s on an 

MP3 player. 



→ There is a clock above the whiteboard, so you won’t need to look at your cell phone for 
the time. 

 Retrieve your cell phone during clean up. 
Class discussions-sometimes we will have class discussions over what we are learning.  Your 
participation is very important for discussions to work.  Sometimes, I will pick, at random, students to 
talk; we’ll call this “teacher facilitated discussion”.   Other times, participation will be voluntary; we’ll call 
this “open discussion”.  Either way, we will use the following procedure during class discussions: 

 You may speak only wen holding the Talking Tool. 
 Eyes and ears should be on the person speaking. 
 The classroom is a safe space—everyone should feel comfortable participation in discussions.   
 Mutual respect—respect the person speaking, and he or she will be respectful in turn. 
 When you’re finished speaking, pass the Talking Tool gently with an underhand toss to the next 

person, after announcing their name. 
→ During teacher facilitated discussion, pass the Talking Tool back to the teacher. 
→ During open discussion, pass the Talking Tool to the first person who raised their hand. 

 During open discussion, raise your hand and wait to be in possession of the Talking Tool before 
speaking. 
 

Finishing work early: 
 If you turn your work in before class is over, you should work on homework for another class 

or quietly read a book. 
 You are not allowed to use a laptop, tablet, or phone when you finish unless permission is given. 

 
Getting students’ attention: 

 When I need your attention I will raise my hand. 
 When I raise my hand, finish your sentence and raise your hand. 
 If you see classmates who cannot see me, ask them quietly to raise their hand too. 

 
Turning in assignments: 

 Turn your assignments in to the assignment box when you are finished.   
 If I ask for your journals, workbooks, or fold-a-lopes, place them in a stack on the floor between 

my filing cabinet and desk. 
 

Procedures for Assignments 
Assignments on notebook paper: 

 Use the proper heading (below) for identifying the paper as your work. 
 Write legibly.  It doesn’t matter to me if you print or write in cursive; just make sure it’s neat! 
 Unless otherwise indicated, you can write in pencil or pen.  If you’re prone to making mistakes, 

use a pencil and eraser if you make an error. 
 You can use either loose leaf note-book paper or perforated paper from a notebook.  If you use 

paper from a notebook, please remove the fringe along the edge.   
 If you are turning in an assignment with more than one page, please staple your work together.   

 



Paper headings: 
 For assignments on notebook paper, include on the left, your name, subject, and the 

assignment.  On the right, include the period, and date due.   In the upper right-hand corner 
write your class student number. 

 For assignments that are completed in Microsoft Word follow this procedure: 
1. On the first page of the document, double click the header or footer area. 
2. Under Header & Footer Tools, on the Design tab, click Header, select Blank (Three 

Columns), and 
3. In the Options group, select the Different First Page check box. 
4. Click on the first [Type text] and type your name and (#).  In the middle [Type text], type 

your subject/period.  Click on the last [Type text] and type the date due. 
5. Close Header and Footer and type the assignment title, centered below the header. 

    
 
Typed assignments that are not scientific papers: 
 Use the proper heading (above) for identifying the paper as your work. 
 Unless otherwise indicated, use “Calibri”, “Cambria”, or “Times New Roman” black, 12 pt. font 

for your work. (They’re easiest to read.) 
 Align the body of the text to left (Ctrl + L); do not justify. 
 Set your margins to narrow (0.5”) 

1. Under Margins, on the Page Layout tab, select Narrow.  (If you’re using an older version of 
Microsoft Word, you may have to manually set the margins to 0.5”; if you don’t know how to 
do this, ask me.) 

 Use double spacing. 
1. On the Page Layout tab, under Paragraph, click the small arrow in the bottom right corner. 
2. Under Spacing, Line Spacing, choose Double.  Check Don’t add space between 

paragraphs of the same style. 
OR 

1. Click Change Styles on the Home tab, mouse over Paragraph Spacing and choose Double. 



 If you are printing and turning in an assignment with more than one page, please staple your 
work together. 

 If your assignment is to be turned in electronically or on a flash drive, it is important to save the 
file with a name that tells me what it is and who wrote it.  Title your document like this: 
Class_Date due (year_month_day)_Your last name_Your first name_period_assignment 
For example, if I were to turn in an assignment call “cell comparison” for biology, my second 
period, it would be titled like this: 
Biology_2014_08_28_Jensen_Julie_Period 2_cell comparison 

 Title your document like this the very first time you save it.   
 
Typed assignments that are scientific papers: don’t worry; I’ll let you know when it’s this type of 
assignment. 
 When given paper of this type, I will provide you with detailed instructions for the formatting of 

the paper. 
 You are to use APA style formatting for your references and citations.  

 
Turning in assignments electronically-sometimes you’ll turn your assignment in on Google Classroom.    
 When an assignment is to be turned in electronically, make sure to title it appropriately (see 

“typed assignments above”). 
 Click the class and then click the assignment. 

→ If there’s a document with your name attached to the assignment, click Turn in.  
→ To attach items for your assignment, 
 Next to Add, click the Down arrow   Drive , Link , or File . 
 Select the attachment or enter the URL for a link and click Add. 
 Click Turn in. 

 You can mark assignments as “done” after you’ve turned them in. 
 

Unfinished class assignments-sometimes we will begin an assignment in class one day and finish it the 
next time we meet.   
 If class ends and we’re still working on an assignment, put the assignment in your folder in the 

class’ box. 
 The next time you come to class, if the assignment is on the agenda, remove it from your folder 

to complete.   
 

Procedures for Assessment 
Taking a test 
 The majority of our tests will be electronic. 
 On test day, leave all of your belongings, except 2 pencils and calculator if you need it, in the 

designated area of the classroom. 
 When you arrive, you will be assigned a different desk on test day. 
 Keep your eyes on your own test. 
 Remain quiet during the entire test time; communicating results in a 0 and you will not be able 

to retest. 



 If you have a question during the test, follow the procedure for asking a question during 
individual work. 

 When you are finished with your test submit it.  If it is a paper test, turn it over and wait for me 
to pick it up. 

 Even though you are finished, please remain quiet for your fellow classmates who are still 
working; communication will still result in a 0. 
 

Taking an individual quiz: 
 Once a quiz is announced, put everything except two pencils below your seat.  Make sure your 

books are closed and your notes covered.  (Skip this step on open book/notes quizzes.) 
 Keep your eyes on your own quiz. 
 Remain quiet during the entire quiz time; communicating results in a 0. 
 If you have a question during the quiz, follow the procedure for asking a question during 

individual work. 
 When you are finished with your quiz, flip it over and place it in the right top hand corner of 

your desk. 
 I will bring you the next assignment when your quiz is flipped over. 
 Work quietly until your classmates are finished. 

 
Plickers, Quizizz, or Kahoots Quiz 
 Treat these quizzes just like a paper quiz.   

 
Taking a pair or group quiz-yes, sometimes we will have quizzes that you can help each other with.  
You will each complete the quiz.  You may be assigned a partner or occasionally choose your own. You 
do not have to help a classmate or ask a classmate for help.  The questions pair/group quizzes are 
timed. 
 Once a quiz is announced, put everything except two pencils below your seat.  Make sure your 

books are closed and your notes covered.  (Skip this step on open book/notes quizzes.) 
 Arrange your desks appropriately.   
 Discuss the questions quietly; you do not have to write the same answer as your group. 
 If you have a question during the quiz, follow the procedure for asking a question during group 

work. 
 When you are finished with your quiz, flip it over and place it in the right top hand corner of 

your desk. 
 I will bring you the next assignment when your quiz is flipped over. 
 Work quietly until your classmates are finished. 

 
Corrections: You can submit corrections for credit if… 

Assignments: You attempted the assignment without cheating and scored below a 70.  You should 
correct the entire assignment, but you cannot earn credit for any questions that you didn’t try to do 
(this includes not showing the proper work or not giving serious answers). 

 You have 5 school days from the time the assignment is returned to turn in corrections. 
 You can earn up to a 70% for corrections. 



Tests: You can correct and retest on any test you took, no matter what you made, as long as you didn’t 
receive a 0 for talking, cheating, or plagiarizing. 

 You’ll need to fill out a Request to Retest form within 2 school days of receiving your graded 
test.  You and your parent must both sign the form.   

 You’ll have 5 school days from the time the test was returned to turn in corrections. 
 Your retest will be similar, but different.   
 You must take the grade you receive on the retest, even if it’s lower. 

Labs:  You attempted the lab without cheating and scored below a 70, if it’s a daily grade, or any grade if 
it is a test grade. 

 Sometimes you cannot simply correct a lab.  Check with me, and I’ll let you know how to do it.  
If there isn’t a realistic way to correct or redo it, I’ll give you an alternate assignment. 

Practical Exams:  You may retake a practical exam, no matter what you made, as long as you didn’t 
receive a 0 for talking, cheating, or plagiarizing. 

 Practical exams are very difficult to correct.   
 Most of the time, you’ll be required to come in during Falcon Period to study the material, 

without submitting formal corrections. 
 Your retake will most likely be fewer questions asked verbally by me.  You’ll still write the 

answers on an answer document.  (Don’t worry, I’ll repeat them as many times as needed!) 
 You must take the grade on the second practical exam, even if it’s lower. 

ADIs: Your final draft of your ADI automatically counts as your corrected version.  Just be sure to turn in 
your peer reviewed rubric with it. 

Corrections Procedure 
 If electronic, access your returned test in Google Classroom by opening the assignment and 

clicking the link. 
 For assignment corrections, use a different color ink.  For test corrections, use notebook paper 

or Frayer models.   
 Be sure to write your name, the date, and the test topic on the top paper and staple them 

together if there is more than one page.  (Yes, you can use the back, too.) 
− For missed vocabulary, complete a Frayer model for each word with the definition, 

facts/characteristics, examples (or illustration if applicable), and used in an example. 
− For non-vocabulary questions, copy the question, provide the correct answer, and why the 

correct answer is correct. Include where you found the correct answer and the page 
number or assignment title; you may use your text book, journal, returned papers, or Fold-
A-Lope. You may not use the internet for this. If you’re stuck, I’ll help during FP and initial 
it. 

− For math-type problems, you must show the formula, the variables, all of your work, have 
the answer in the correct number of significant figures, and include the units. 

− For illustrations, you should sketch the illustration and label appropriately if required. 
− You will not have to correct practical exam-type questions on a test.   

 Practical exam-type questions are questions that test skills and technique.  For 
example: 
 What is my blood pressure? 
 Name this bone, (and there be a bone, not a picture)  
 Flex your knee. 
 Perform electrophoresis on this DNA sample and identify the suspect. 



 
 

Procedures for Absenteeism and Tardiness 
Absent folder: if you are absent, a classmate will prepare an absent folder for you. 

 If a classmate is a group member of yours, please make them an absent folder.  Get the 
appropriate colored folder.  It makes me happy if you do this without me asking. 

 If you’re asked to make an absent folder for a classmate, put any materials handed out in class 
in the folder.  Put the materials in order, with the newest materials on top.  I may ask you to 
write down the assignment for your classmate. 

 During the time to clean up, put your partner’s absent folder in the class’ file box in their folder. 
 If you are absent, a parent or guardian can pick up your assignments from me between 3:30 – 

4:00 or you can get them the next day.  You are welcome to copy a classmate’s notes if there are 
any. 
 

Tardiness-The school’s policy on tardiness and discipline can be found in the “Parent-Student 
Handbook Code of Conduct”.   
 

Emergency procedures: 
Emergency preparedness: Fire Drills 

 3 bells indicate a fire drill and that it is time to leave the building.  When you hear 3 bells, turn 
off any Bunsen burners, put all chemicals in the vent hood, and calmly line up. 

 Do not bring any personal items that are not already on you.   
 If there is a substitute, the last person in line will bring the Emergency Evacuation Binder if the 

substitute did not pick it up. 
 The last person in line will turn off the lights and close the door. 
 Calmly and quietly walk on the right side of the hall along the evacuation route to the assembly 

area. 
 If you are in the bathroom or getting a drink of water, you are to immediately and quietly 

proceed to the assembly area. 
 Once in the assembly area attendance will be taken.  Respond to your name by raising your 

hand and saying, “here”. 
 1 bell signals to halt and stand at attention.  Remain calm and quiet. 
 2 bells signal it’s safe to return to the classroom. 
 Return to your seats. 

 
Emergency preparedness: Tornados 

 1 long continuous bell indicates a tornado drill.  When you hear 1 long continuous bell, turn off 
any Bunsen burners, put all chemicals in the vent hood, and calmly line up. 

 Do not bring any personal items with you. 
 If there is a substitute, the last person in line will bring the Emergency Evacuation Binder if the 

substitute did not pick it up. 
 The last person in line will turn off the lights and close the door. 



 Calmly and quietly walk on the right side of the hall along the evacuation route to the assembly 
area. 

 If you are in the bathroom or getting a drink of water, you are to immediately and quietly 
proceed to the assembly area. 

 Once in the assembly area attendance will be taken.  Respond to your name by raising your 
hand and saying, “here”. 

 Sit against the wall, as close to the floor as possible, with your forearms protecting your head. 
Remain calm and quiet. 

 2 bells signal it’s safe to return to the classroom. 
 Return to your seats. 

 
Miscellaneous Procedures 

Guideline infraction notice: 
 IF you choose to act inappropriately, you will receive a “guideline infraction notice”.   
 I will quietly place the notice on your desk.   
 If it is blank, then fill it out. 
 If the “See me after class!” box is checked, you must come see me when class is over. 
 If the “Parent Signature” box is checked, have a parent or legal guardian sign the slip and return 

it the next day.  
 If neither the “See me after class!” box nor “Parent Signature” box is checked, then sign the slip 

and put it on my desk during clean up, or hand it to me when I come back. 
 

 


